IBM System Storage DS3500 #1 EXP3500 #Z2Z23EF0dE N7
i1E7]
A (LA ZEFIREA T THEETY iR T 423 IBM® System Storage® DS3500 77T ZR %1 IBM System Stor-

age EXP3500 fAitllHE A FE, 1230 1945 EOE T DS3512 il DS3524 it 7 &4, DL EXP3512
1 EXP3524 1Ef#HLIE.

A A DS3500 ffi T R 58 S EXP3500 (LR SEATIEL ML ERE R, HS M BERY (IBM System Stor-
age DS3500 Fll EXP3500 %%, JH P 544745/

H % DS3500 FIH A IBM System Storage 7=fnf3%iI1M5 8, &1/il |http://ibmdsseriestraining.com/

4% IBM System Storage BARLAF IR (ALFEFTA DS3000 176K T RAMIHIE ) MERHEE, HHE
[www.ibm.com/systems/support/storage/disk|

HTHEEEE, WERXP CD FZIEF AN (IBM %25 E) UM,

pEEEET

EEMUEXARA SR, TMEEMNELEE, EVEIA R ZEFH T REZN, WEE T

iy

o TEMUEAMAE 2% 18 T35 (39.7 %) s EHRAHFEMNNHFEL AR,

o WRENIRIET 35 BIKE (95 EEKF) |

o iEIHFEATATE XL, R EE 15 K (6 ¥sh) ASSERARIE S S IE RS,

o HOENE VAP CLENEM T REM BT BB AEMECFS R, b T eI T Rad
P, HIRLLAEIATTIIAY,  DIIE MO A (8] RS B i A 25 SIE # it i

o EIERA LT TN LA 706 T RS SRR,

o TRELANE, BEMHLIE AL IR FE L.

o SR B A TENLAE LA 0 SRR,

o OREE[R I AR AL LA A1,

o FELAEMAN], AT 7 GERAE, SEE UL TR AL,

o AT RS AU I 42 B 1 ) 122 b 1) 4 82

o TEMUERAMUAE R 22k AT, 35 270 fi P YA A A T

s FHTREEY EIEREYRR PR 2 U iz,

. @
R R % 2 1.

=18 T (39.7 232 Fw (70.5 255 F3 (121.2
%) %) )


http://ibmdsseriestraining.com/
http://www.ibm.com/systems/support/storage/disk
http://www.ibm.com/systems/support/storage/disk

i&FAF NEBS ( MRiZ&EHEZRY ) GR-1089-CORE HIHEFZEZEE
IT U T C 418 E NS NEBS (M5 &l 5450 ) GR-1089-CORE FrifER) IBM 71X 4.

BB I8 A LT
o IS REE 5 B
* NEC (NFPA 70 [EZAMIE) & IO E.

St
TE:

HSTEFHRERAERAN, NESNREL (EL) LRFERF B MIRERLIET.

T

o BEBCR Y PN AL A i 100 T 3 1 B P SO T R A R R S R B L, BB A AR A e 1 4

XEAREE A & R 2 TR OSP (AMHL) ) s Lien, X O UEN D
(GR-1089-CORE Tssue 5 sl il Pl il 2 i 4 U ) R EGREEH OSP #HLk
BRIk, AR ORI A A DU PR X 21 Ll B Rk 2 OSP 12 i i A,

o A FEL IR Y R GEAN TR B AL IR AR 37 & (SPD) |
o EATE A IEA RGCR A T M B ENA (DC-1) BEvt, B I A [ 3800 AN RE 4R B LA B4R

k.

o ffEveE (EUAE) BFEZ34E GR-1089-CORE Issue 5 s il lndng «AERM L (5%

RARMZE ) .



==

BH

DU BEAE B e iR TAEALZE MR TR %225 DS3500 76t A4t o EXP3500 fFAEHNUAE T as 94, ik &£k 5
PR TATA — A0, 3-S5 &,

iE

L.

R DS3500 5 EXP3500 ] HHAE, ARl aetl & Ll iE B a v A &, &5 0 R
W «IBM System Storage DS3500 F1 EXP3500 “Z:%:. JHF' G445 FR I PEAEIGE 8, DL T AT far Hifl
B, FEEE A DL E Bk FHIZIE .

BER A EALEE R R, DURMIRAE, JE4HmiEF S 4 iSCSI 155 48 Bl (4R A Rl A B A, DL T3
Ferp R AL A X BErEE 4,

FTFF DS3500 #, EXP3500 [fudiz )5, HRIEENME T RESUF Y RS 5 DU & DY) &
o WA SRR (12 D24 D) (BT RE ST BUE R Z AT 24 DIKShEE ) |
+ RAID #iil#F ({XFR DS3500, &% 2 1)

o MBIk FSHEE (ESM) (LR EXP3500, 1 4>)

© APHLIEALS

- SCHLAIRAIRUE #IE (2 4)
— HURBREHIEE L (2 1R)

© HIHEJES:

- EHAHEBEMXEERIT (2 1)
- HBELAELE (2 ])

o DURZAGREMF T EM (1 1), Wi

- ZESH (2R, EHAEMH)

- M5 RESNAARIRET (8 i)

- M5 #E (6 1)

- NERBRHR (8 4, D&%, BIREH 4 1)
- KERZHBRE (8 1)

— M4 CFSLIBRET (2 )

T TEX B2k, DS3500 1 EXP3500 FL i HLIE LS R BT -48 AR T I v 5 e e B i 0 1
30 LW TERAE A (WTEE4S) . 1550 (IBM System Storage DS3500 Fll EXP3500 %%, i 1 54k
gy, DIBRIEUE 2145 B

TH

FE4%E DS3500 5% EXP3500 Z i, ZeX i B FHAsmiEs:, HAEUmEAUT TR
© RIBFET RGO A FHESE

« 5 2K (3/16 Bl ) —FIET]

« iR A TR

2 SR I 8 AT (k) |



Z A

2% DS3500 # EXP3500 ¥ K DL T il #2:

I [T E#R T AR ]

2. [ 5 5l  ZE G ]

3. [ 6 T T B AT RS UL ) ]
4. [E 10 U 1 B bE 7 2 A bR 2 E LU T o |
5

6

7

8

9

BT TR - S ]
NERNSETEET I

@ I RPORR BT RS

[ 16 5 T AR BOR A “IBM_ %% Web i SIfEE ]
BB e T AT R S A

10. [ 17 U 1 iRBE AT AR ]

IAFETREENESR

=iA 4

A

o

=z 18 T (39.7 %) = 32 F5% (705 %) = 55 T (121.2 B%)

-
N
TE:

HREMER AR 2.

AT T AR RAUE R e, i sE Ll T 33k

Lo 2R =N, MR B A R sl AU K O T 45, S Al i P i
E

2. KRR RG Y RAUE, WROREIE] T RTE LR AR, TS AR 3 DUy 1 0 RSy, DL T A
T ARG RYVE & A EpE.
3. BB KPS MS IRET, SRIGARSYES 5 DU o RS |




REXIESH

iE:

L A ERAHNA, BT RN LS PEFNE VU P B b
2. MAREFELZHAMT RS, WHRAAEMYEN M T RE AT 78— 2=,

3. ZESBM RGNS HIRE L MR

FAENUBE AU o 2288 e SO U S L, il e L TP IR,
L WESHESPOIME, ITARPIBS IR IRET. IR IRET AR SR R PBUE e — K.

AT IRET

[ 1. R TRET

2. RAEA XHESHMETES, B EEN AP MG RN, RER S SHNEE, EHE S0
SRS HUARG SR G B i, ¥ ST P S UE SRR T I AL LS SR L, allE 2] R,

i WAV A TTIEAL, R PR RS A /N R O S U P BB Y O

[coo®o®ooooo)
0 0
\ \

/ /
/ /
\ccoeoococooog]

7 7

[&l 2. Fg P E VIR

3. FEX SE RN G SR SHE S PG G 20, MWL AHURIRYATES,  FHIRZZ T)f — il MS 8257
Fr SRR SR —AfLrh, WlE 6 SUAYIA 3] B,

i AEFIMIBR RN G ERTTIBAL R MS IRETIN, 3iF 95 0 i AR E



M5 BRE] (1 8D

\
\coocooesooo0o]

[coocoom o oo o)
/ /

M5 B24T (2 JiD
[E] 3. K 3 45 L E B

4. WHLRAUAEG 8, FIRZTIKPI MS SRETH7 A JE S B S R G R AL A2 — A fL A,

eI M A TAL S MS TR, 3 45 A0 0 P2
5. WTHERHESH, wEEEs nm 2 & 0 £,

HTFEFRESY BUELY

R AT RSB BAEZ 8T, &6 H T sl ESM, Sufidk ik s g8 DL 5 B 5 AXUG BT, OB 22
FEME] DS3500 # EXP3500 & &, DS3500 Fl EXP3500 J5 HBH0 A 20 (4038 i Flr A 808 18 S B AT
[ 52

LETAM, WM 2R,
i£: DS3500 f7fifi ¥ RELM EXP3500 § FEAUEME AR AR, DI, T AL,



[ 4. )k DS3500 f76E T F 450 EXP3500 AL I HE IR

1. I HJE:
a. & TFRBECR O FROIR, WE TR, BB EIEEY 0.6 JEK (0.25 )
b. HHEJEEEERE, FHET %

5. J EXP3512 5% EXP3524 i T ESM

2. MR EA EXP3512 # EXP3524 ¥ J@HLE, i5HI T ESM:
a. FTHPRBE. ESM B EHE4EZ) 0.6 JHK (0.25 35 ) |
b. ¥ ESM (IR, HET 5.



T BT

& 6. M DS3512 5 DS3524 I TF#H8

3. WIRHEA DS3512 5 DS3524 1+ £ 4%, i5H T iEH s
a. FIFFPIRBET, R R, BEHEE R S22 0.6 Bk (0.25 #5F) |
b. HAEHIE T IR, FET 5.

CEREEE

YRBh TR

& 7. M DS3512 5 EXP3512 571 fif 40K 548



YA AT

& 8. M DS3524 5 EXP3524 il F i 519K sl 4

4. HIFIKBhE:

o ONIRSNENG AR, DUE AT DU S Y R AT e

- PR A A R o PN DA RO Sl b 3 .

KGR SRS BT IE, YT IR, TSI ATERE 90 FEA.

- OBIR S IR L.

e YRS, EE ST By B Bd

5. S RNAEBEM A KIBM Systems Storage DS3500 Fll EXP3500 2%, J /7 G458 , DL TMAXHT
AU HE 215 A

(=T =

[¢]



B EFEFRERFENERZZN R IED
BT R, LT
LB T RSB B LA 9 % 4 i

2. KPR T RS BB G H00 A S8, Wl 9] g DS3512 A EXP3512 LI RE 10 i DS3524
' EXP3524 iR,

B G

o

& 9. % DS3512 5 EXP3512 il EFPLZH

iE: DS3524 Fl EXP3524 A X ERHNF RO,

& 10. % DS3524 T EXP3524 & T4
3. B AEE T RGP AR B AT 22 L5 B S HURTHERI) 2225 fL X 5%,

10



4. f§—I MS RETIR AL T ARG R YUK R0 S5 FL R4 47 %, i 1] Hig DS3512 8}
EXP3512 DIMJE 12] dify DS3524 s EXP3524 .

M5 IR

& 11. % DS3512 @ EXP3512 [EEZIHL4EH

R
v
\ X
o, e Ve 0000000000000

M5 BRET

& 12. ¥% DS3524 5 EXP3524 [5:Z#|Hl%EH

5. KR M4 RAT B SR S U SR AT B R G ST U MU B 4 AL P R AT

11



6. FHIHT RAENY BIUE Lo Adimn, 1 13 im, SR s pm i S U M 4 LR axlsE, OF
I T e A 2 e A B, W AR AR P O T S5 LA 5 T

[E 13, ZEEFR
7. FAELHE 6 BUH 1R A ARG S RUUELLE 1 R E T (R T RS RATLAR 414

E=¥
% & LR IRE R AR R _ EAR IR X TRt R A IE FEE. EEETRESREREZ. B
BEHFERRE BEHRAFHREXLCSSHEIENTERE.

VAN

2 [() mp =
1 [ mp =—
Eo W IRDL T i AR R R AT R, B A A IR MUE L U AR, 2/DE RN

PLA B PAACRL T (PDU) | R MIUE BRI I BB AL /) PDU. K5, 5 PDU &R A
[F] FEL B L Y &/ FEL 9046

BT 7 RS IR, 58 AT 2 5%

AT T R G R L 2k,

B B L TR Y 57 — i 2 32 1) P 04 .

FTOFHREITC (IREM) .

TTITHTA C R UUE LA LEITR, JF455fF 60 £,
T R LRI AR IR TFOC,

A



iE AEKRMIT T RGEREN, TR IRAR SR e Bk R BR. E kMR T R, AR K
VAT et DUAEL A FEL O,

FIFREIR - ERES

=R 29:

A A

TR
W EHIGTARITFERBREENENSEAEZIEENEMSE. MRELTIERE, BAVRHEUAT
B &

S BB

¢ B R T A B — R A RS B S 5 B R G O SR L R [ R
AFREI—HEMXE (FIINIEEHNGE) . BRAS SN .

« HRBENSEZEER—ZHYP.

« FRIEFHEFERE &R NEERBIRENRSEERE S Z RSB ESED.

=R 34

A A

pE =¥

EMERB EREE ER AR

« WRASHEIINRS A RZIEE REERFIZENMAE, 0 NEC and IEC 60950-1, First Edition, The
Standard for Safety of Information Technology Equipment FRIE X .

© BiZiREERI T EERMAZEEKAE (SELV) BiF. SELV BiRER—/MHEBRE, BATHLEBREELE
EEBEFBENMBENERTBEZ2E5 (60 KERE ) .

o ENFMER, MACZESFESTHEFRTARMET T ERILE.

* BSRFRXETHNE, UTHS ZBEETRAIPRLEESRGEE.

© NERRLIE. BSRFRIEFRINE, T RARERE LIRS,

s BBRAFEXEPRNE, LT RESRESHNTEHEE.

BT+ R BT, #5225

L. BAORAFfF FRGE S AC EE AF LR o 9 1 DA P DR ) P R T DR A T S I

2. Hr H IRk S AR B R A i RGP Y A B IR DL A T R R AR R AILAR:
a. fFRALRGHRILER, # BB IRZEER 25, DUE A IR AR (] R 5 2.
b, K EHEIFLEESMEIE, 2R 14 U 14 RES 14 0 1 DU T B R R O M S 0 E

13



ey

+ @

[ 14. BiERZO - 5100 E
K1 HmBEED - 5 #f

w/S IRE HRBRELHE
1 S 1 -48 REWH PRt

2 5| 2: POS RTN Wt

3 5180 3: GND LR/

c. BrHEMHEIELN -48 R (B EEIAMUERNBUEME N 30 RN THERER & (W) |
fefs N DS3500 F1IT [ 1 M FE s BRAERr ik &
&5
o WiFERRE (W) RFEELAN 30 2,
o HHAUE] 10 AWG B4R SR 28 k% 3 DS3500/EXP3500 B i F I 322 11 1 B 3 Fi L4 e
d. W E R S EAR n B 224 BAHE IE (SELV) BB IREE FFrid h 48 (REyEdm, HHE

WAL POS RTN HiZk ([ifn) FiMhsk (/86 ) EBF ER A BIEE FF/0k POS RTN
GND ks, W& 15 ATz,

ooooo

@@ G%Mnmz OO -
B N
—
-+ @
BB B g

&l 15. K DS3500 FH7 TFi% #1545 U EL It FE 7 4 J3E 1) L 2 24
72, T HE A R L A

w/S Ihee

1 S 10 -48 {REFH
2 5l 2: POS RTN

3 Sl 3: GND

4 EER/GERE D

5 W A (TS )

3. EHEMAERMEKBEY )R, fTIF -48 KA WAL SELV HL 5 & Y LA

14




4. FTTPTA C M BEUUE B PAIIETTR, JF%ERF 60 A,
5. T T R LRI B IR TR,

E ARSI T RGERIERE, TR A R U e Bk A BR, E R R T R, KR
VA RERILIE ARV, J50J5 DG T BEE 48 AR SELV HLJRIHEE I b7 F i 1 4%

TR

S RGO THEALE PIFER, EHLmfAE T RS LUN ki Admil (/0), B P E BT &
S, VFEALRTIE EAUA/SCE B R T RS s s AL Z2%E IBM System Storage DS Storage Man-
ager #f4F.

i IBM SZHF Web ufi gi BRI T EXT REAE RGN AT A ) Storage Manager fF, B THMEZEE, 1F
S 16 T 1 RBOKRE “IBM 4§15 Web UG5 E 1 | 1766 T RGHM 1 DS Storage Manager DVD
YR AT RUAS T REAS 2 5T AR

EEE &3 Storage Manager
BLTEE G | 42%E Storage Manager #/F, i 5¢ ML T A0 BR:

1 AREAT LI AR, G IBM % H Web 35 FEURHi R ASHY Storage Manager %1 (3% #[E 14
B9 KBORA “IBM % FF” Web i mffE A o) DIKICE S5 ) . W ARREVT R FFFR, e Bg
LA DS Storage Manager DVD, F1483i&E & HH#AE R 00 H 3.

i EHEB BT EAE RERBTER H R(UFE DS Storage Manager DVD W fit, HREZFEL, ES
% DS Storage Manager DVD N EAE RS AR WK shAE FF B i SCHF.

2. Wi Storage Manager W HATSCHF, BAGLAE M S AR/ E R, TR0 AAE 1 AR 7RI B4 DL R B 1R T
o MR VFAVALHIEE B, 54 Management Station,
o WURITEVUR HEE BS A EAL, 5% Typical (full installation),

3. MR ENUE LTS ES O ME — 1ML, E LR PR RIHESE Automatically Start Monitor,

i WURHAL RSB AT RS, IBATERE X B, iE2)9% 4 Automatically Start Moni-
tor, 7EH IR R AT Do Not Automatically Start the Monitor, 7|, FEfEfEF R4 Kk
[ RBUE, He 3% 22 A i .

HEEN L RFRH

BB, WL T 2R

L AT EHLEZOERC A (HBA) HJ BIOS MU IKSIAR A, WA E, W L3 Z Ak e85 A
IBM ZHF Web 3 i B SLRIGEHTRA (FSH[E 16 5T 1 3RIBOEEH “IBM SCF> Web sl {8 1 |
PIRBUE Z 58 .

iE: HBA [) BIOS Mk & Kshfe 7l B IBM R Web ol BRI, ETMEZEL, ES6HF 16
[y FRBOEH “IBM %457 Web 3 HE 1 |
2. FRZEARWENRE FRE MM EU HBA Bt F REERIS e, AXELER, 12 (IBM Sys-
tem Storage DS® Storage Manager V10 M FEH L H#15H) .

R REFRTRE
ERIIFR BT RS, WL TR

15



1. WEBE R Storage Manager #/F. iXFEL4TJHF Enterprise Management & [ Confirm Initial Auto-
matic Discovery [,

2. M Enterprise Management 7 [1*i%#% Automatic Discovery, DIAIGET RS, 10 E sh AT
J&, Enterprise Management % [ 27~ O % 2 2 A< 1 W oh 19 BT A5 HURIA7 0 T R 4.

iE BERAMTFRAMNIFH T RS, il Edit > Add Storage Subsystem, T T AfF T R45E
AR M A 1P Mk SRR EALR TP HidE,

3. ¥ Rename the Storage Subsystem. ffi fl DS3500 (/55 54E NF RFE LTI T — 585y, TW &5
L8 30 NFAF.

4. Hif; Locate the Storage Subsystem, frififffifi ¥ FR 50 1E MBI RTS8 2T R 0IH
K AAFRN S ATHRE.

5. R BIRIAET RS, A5 Had Tools > Manage Storage Subsystem [){]Jf Subsystem Management
% A1 Task Assistant,

6. WRFMH T REARL T RAEIRE, BAGEHT Task Assistant 1] Recover from Failure [Ef5, %1
Recovery Guru HZBRIATEANE, U T REAL T R AARAESRE, 75 CH] Task Assistant,

7. 1E Subsystem Management 7 1+, .i; Storage Subsystem > View > Profile, #.if; Controller Firm-
ware, NVSRAM, ESM Firmware, Drive Product ID #1 Firmware Versions LI, &8 Fic
SEAE T R DR kA .

Controller Firmware:
NVSRAM:

ESM Firmware:
Drive Product ID:

Firmware Versions:

8. MRAFMEESCAFLIBLR R, AR5 R ESCFE A,
i XA T ARGV BN, H AT T ARG E SR R R PTA SCR AR R AETEIA,

KEURE “IBM %5 Web ifSfIEE
A[fE “IBM EZHF” Web ufifi FIRE] (#EATTIFRY FHiAR) IBM System Storage SCRPL K HA IBM Sys-
tem Storage fF . ZAE “IBM (FF” Web uli sl Byl SO, T L HABBORTEH, 1§52 L IR,

iE: IBM Web i s Wi A8 . A 1 R SORS A aod Re n] RE S5 1% SO BT iR R AR AN [
1. 5510 |http://www.ibm.com/systems/storage/support/
2. 7£ Select your product /) Product Family FEF#ii; Disk systems,

3. £ Product 7B, HEAHN ™ M4, ARG HdE Go.
4. 1 Support & downloads T, HiiAH R ) HR20

E BT A ST AR e A CERAS VR AN S, A DR SRR 3 TR B BT AR SO

EEFETREE G

RS SR 15 T ¢ AT o PR T 3R, B4 Storage Manager FHLIUAS, HBA BIOS Fli%
UK SRy Y B Y.

16


http://www.ibm.com/systems/storage/support/

TE Subsystem Management % 19, #.{; Advanced > Maintenance > Download, #%[f %7k sEl T
VeI

L A5

2. ¥EiHl4s NVSRAM

3. ESM [{F

4. BRZHE E A

RETFHETRSE

{E Subsystem Management % 1+, Hi; View > Task Assistant, U7 0E T ARG T HRAERS, HiKR
AR 5E A T AL 55

L S0 2R 80 1Y ) RC 2 4
2. EXLFEN

3. AEE A A X

4. RAEBCE

5. WE R UEY

17



18



HRAE T IBM System Storage DS3500 1 EXP3500 {7 T &4t, HAEGI#RE AR 7.70 DL A G 2L &7
BITH, B EIFEB A 5578 7 B A Ak,

Printed in China

IBM #il System Storage /& IBM Corporation 7F 3& [ l/af H A [E 5 st D<A R 5.
Microsoft #1 Windows J& Microsoft Corporation £ 3% | Fll/ml A [ 5 ol 1o X1 s .
© Copyright IBM Corporation 2010, 2013.

S151-2134-00



	IBM System Storage DS3500 和 EXP3500 机架安装和快速入门指南
	机架安装准则
	适用于 NEBS（网络设备构建系统）GR-1089-CORE 的电源和连线信息
	清单
	工具
	安装概述
	打开存储子系统的包装
	安装支撑导轨
	卸下存储子系统或扩展机柜组件
	将存储子系统或存储机柜安装到机架式机箱中
	打开电源 - 交流型号
	打开电源 - 直流型号
	安装软件
	在管理站上安装 Storage Manager
	在主机上安装软件

	发现并设置存储子系统
	获取来自“IBM 支持”Web 站点的信息
	更新存储子系统固件
	配置存储子系统


